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1. Data Plotting – SEL Specific Views: 

 

Updated August 10th, 2022 

 

Added support to have a view for each type of SEL Relay. The view can also be automatically applied 

when the SEL files are opened. To create the SEL views first select the SEL file in the File Manager. Next 

open a summary of the file by selecting Summaries under the Options Tab/Menu. The Device Type listed  

under the File Information section shows the name of the SEL view file. 

 
* File Information: 

* ------------------ 

            Station: MCC 202 

             Device: MCC SUB 

          File Name: C:\FAULTLIB\TEST\150428,070428709,-5,Station,SUB,Comp,AG,-XY.CEV 

          File Size: 92496 Bytes 

      Prefault Time: 4/28/2021 07:04:28.629834 

         Fault Time: 4/28/2021 07:04:28.709000 

          Save Time: 04/29/2021 07:47:06 

       Process Time: 08/05/2022 13:36:37 

  Start Date & Time: 04/28/2021 07:04:28.629834 

    End Date & Time: 04/28/2021 07:04:29.692334 

      File Duration: 1  Sec(s) - 62 Mils(s) - 500 Mics(s) 

 Sampling Frequency: 240.000000, 4166.667  Microsecond Rate 

     Line Frequency: 60.000000 

        Device-Type: SEL-751A  

 

For the above summary the SEL view must be named SEL-751A.VIW. To set up the view open the SEL file 

in the Data Plotting Window.  

 

 
 

Figure-1: SEL Views 
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Once the file is open setup the view. 

 

 
 

Figure-2: Setup SEL Views 

 

In the view above the voltage channels where moved to the top. The VS, VBAT and FREQ channels 

where deleted. Each channel was assigned a color and the sampling frequency was increased from 240 

samples per second to 2400. The 3 voltage channels where super imposed and the 3 phase currents 

where super imposed. The analog channel table was resize to show Title, InstVal, RMS, Phase and Units. 

To move the analog table columns open the Properties dialog and select the Analog Table tab. 

 



Softstuf Documentation 

3 

 

 
 

Figure-3: Properties Dialog/Analog Table Tab 

 

When the View is complete select the Save View menu option under the Waveform tab. 

 

 
 

Figure-4: Save View Dialog 
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Enter the SEL Device type displayed in the Summary window: SEL-751A. The extension is not needed. It 

will be automatically assigned the .VIW extension. Select the path where the View will be saved in the 

View File Path field. All SEL view files can be saved in a single path accessible to all Wavewin users. To 

set the path where Wavewin will look for the SEL view files select the Driver Config menu option under 

the Options tab in the File Manager.   

 

 
 

Figure-5: Driver Configuration Dialog 

 

Set the Driver’s Header Directory to the path where the SEL View files are saved. Set it for both the SEL 

Long and SEL Short drivers. 

 

To have the view automatically opened when and SEL file is opened select the Display Properties menu 

option under the Options tab.  
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Figure-6: Display Properties Dialog 

 

Select the Data Plotting tab. Change the first field, Open View, in the General Settings section to Yes.  

This setting will apply the SEL Views when the files are opened. 
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2. Data Plotting – Invert Marked Channels: 

 

Updated August 1st, 2022 

 

Added a new option in the data plotting’s right click popup menu to automatically invert all the marked 

analog channels. To activate, first mark the desired analog channels using the spacebar or mouse. Next 

right click on the analog channel table and select the Invert Marked Channels menu option. If there are  

no analog channels marked then this option will be disabled. 

 

All of the marked channels scale factor will be multipled by -1. To restore the original, mark the channels 

again and select the popup menu option Invert again. 

 

 
 

Figure-7: Invert Marked Channels Popup Menu 
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Figure-8: Inverted Channels 

 

3. File Manager/Data Plotting – Save As: 

 

Updated April 3rd, 2022 

 

Changed the Save As Comtrade in the File Manager to a generic Save As feature. The Save As Comtrade 

menu option under the Options menu has been changed to Save As. The new Save As dialog allows for 

directly selecting the Save As format (Comtrade 1991, 1999, 2013 Ascii or Binary, RMS, Instantaneous   

Values, Vector Values and Summaries). Also added a Save As menu option under the File menu. The new 

Save As dialog has a drop down list box to select the format and radio buttons to select the files to 

process. 
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Figure-9: Save As from the File Manager 

 

 

 
 

Figure-10: Save As from the Data Plotting Window 

4. Device Manager – SFTP Client: 

 

Updated February 2nd, 2022 

 

Added a new file transfer protocol to extract files from an SFTP Server.  The new SSH FTP Client works 

the same as the current FTP Client with the addition of password authentication. To specify  an SFTP 

connection select Ethernet in the connection Types section of the Device Configuration dialog. Then 

select SFTP in the Protocol list box. The SFTP Client connects to the SFTP Server using the username and 

password defined in the device configuration dialog. Once the connection is established the SFTP Client 

requests a DIR list for the specified remote path. It then parses each file/folder in the list. All files that 

have a date and time greater than the Current date and time displayed in the Change Polling Start Date 

& Time dialog are marked for retrieval. 
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Figure-11: Change Polling Start Time Dialog 

 

If the File Names field in the device configuration dialog is set to Rename to ComNames then each file 

extracted will be assigned a date and time in the first 2 fields of the filename. If the files being extracted 

are Comtrade files then the fault date and time listed in the CFG file is used for the files date and time. If 

they are not Comtrade Files then the date and time listed in the DIR from the SFTP server is used. The 

directory listing from the FTP server will include the date and time if the file’s save date is within the last 

6 months. All other files only list the date. For files that only have a date in the listing the software will 

assign the file a time of 01:00:00.000. And if there is the same date for consecutive files then the 

milliseconds are incremented. 
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Figure-12: SFTP Configuration Dialog 

5. Data Plotting – Restore Original View: 

 

Updated February 2nd, 2022 

 

Added a new feature that will restore the analog channels, digital channels, phasors, and the analog 
table back to the original view when the file was first opened. To restore the original view select the 
Restore Original View menu option under the View menu in the Menu based system or click the Restore 
Original View icon in the View section under the Waveform tab in the Ribbon System. 
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Figure-13: Restore Original View Menu Options 

6. Device Manager – New SSHClient Component: 

 

Updated December 1st, 2021 

 

Replaced the existing SSClient component  with a more reliable component. The previous SSHClient was 

designed to work with ASCII communications only. The new component supports both ASCII and Binary 

communications. The new component also has a better support team.  

7. Data Plotting – Sort Digital Channels: 

 

Updated December 1st, 2021 

 

Added a new feature that will sort the Digital Channels according to the change of state. This new 

feature will sort the first change in state in Ascending order or sort the first change in state in 

Descending order. There is also an option to restore the order of the Digital Channels when the file was 

first opened. In the menu system there is a new submenu under the Channels menu called Sort Digital 

Channels and in the ribbon system a new drop down menu was added to the Channel tab under the 

Arrange section. 
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Figure-14: Sort Digital Channels Menu Options 

 

 

Figure-15: Sort Digital Channels in Ascending Order 
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8. Data Plotting – Append Files: 

 

Updated December 1st, 2021 

 

When Appending files only the files that have matching analog and digital channel titles are appended. 

The scale factor has been added as an additional check to make sure all analog channels appended have 

matching scale factors.  

9. Data Plotting – Sequence Components Calculator: 

 

Updated December 1st, 2021 

 

Added an option inside the Sequence Components calculator to always use the displayed channels that 

are selected in the voltage and current drop down lists. A new checkbox has been added under the 

phasor diagram to specify that the channels selected in the drop down boxes be preselected when 

opening the sequence components calculator.  

 

Figure-16: Always Use Displayed Channels in the Sequence Components Calculator  

10. Device Manager – Relay Tech Polling Configuration: 

 

Updated January 20th, 2021 

 

Created a generic polling configuration for relay techs to poll relays in the station without having to edit 

the configuration to add the station and device names. The station name and device name for each 

record in the device manager lists the type of data to retrieve from the relay. For example, one record 
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will have Compressed Raw in the Device Name field and Event in the Station name. When the device is 

activated to poll the relay will download all the new Compressed Raw event files from the relay and 

name the event files using the IEEE Comnames format. The device name and station name will be 

automatically populated with the Relay ID and Station ID fields listed in the event file. Below are 

examples of the Relay and Station Fields defined in a compressed format and an ASCII format located in 

the event file. When an event is extracted from the relay the SEL driver will automatically look for the 

Relay and Station ID fields and put the fields inside 2 variables: RID and TRMID. The RID variable will 

replace the Device field in the IEEE long filename and the TRMID variable will be used for the Station 

field in the filename. The Device and Stn-Group fields will be added to the IEEE long filename in the 7th 

field, right after the Company Name field, see the example filename below.  

 

Wavewin will only perform the automatic naming of the files using the Relay and Station ID fields from 

inside the event files if a file named Relay_Techs.INI exists in the path where Wavewin is running from. 

The Relay_Techs.INI file lists all the possible titles a relay would use to label the Relay and Station ID. If a 

relay uses another title to represent the Station and Relay IDs add them under the proper section. The 

Relay_Techs.INI file lists all the possibilities for the Relay IDs under the [RELAYIDS] section and all the 

possibilities for the Station IDs under the [STATIONIDS] section. The two sections must be separated by a 

blank line. See the Relay_Techs.INI File Contents section to see the format of the file. 

 

Compressed Format 

"FID","RID","SID","03E2" 

"FID=SEL-421-R113-V0-Z004005-D20050119","Relay 1","Station A","0f13" 

 

ASCII Formats 

SID     := "Station A" 

RID     := "Relay 1" 

 

RID   =FEEDER 1                       TID   =STATION A    

 

Example Filename 

181003,21272145,-5,Station A,Relay 1,Softstuf,Event-Compressed Raw,100.000,$$$.$$,TRIG.SEL  

 

 

 

Relay_Techs.INI File Contents 

[RELAYIDS] 

MID 

RELID 

RID 

 

[STATIONIDS] 
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TID 

TRMID 

SID 

11. Device Manager – Event File Type Field: 

 

Updated January 20th, 2021 

 

Added an option to add event commands to the Event File Type Field’s drop down list using a file called 

SEL Event File Type.INI. When the Device Manager is open, it will check if the SEL Event File Type.INI 

exists in the path where Wavewin is running from. If it does not exist then it will create the file with the 

default event commands that currently exist in the Event File Type drop down list. The Event File Type 

Field is stored in the Command field. Currently the field stored in the Command field is a letter or 

number that corresponds to each title listed in the Event File Type drop down box. The current letters 

are listed below with its corresponding title and outgoing command. 

 

Storied Letter/Number  Title    Outgoing Command 

0    Default    EVE # 

S    Short    EVE # 

L    Long    EVE # L 

R    Raw (Unfiltered)  EVE # R 

C    Compressed Raw  CEV # R 

X    Compressed Raw L60  CEV # R L60 

D    Compressed Default  CEV # 

B    Compressed B Command CEV # B 

A    ASCII EVE B Command  EVE # B 

 

The # in the outgoing command represents the Event number. The system now stores  the number that 

represents the position in the drop down list box. For example, the new stored values are listed below: 

 

New Storied Number  Title    Outgoing Command 

0    Default    EVE # 

1    Short    EVE # 

2    Long    EVE # L 

3    Raw (Unfiltered)  EVE # R 

4    Compressed Raw  CEV # R 

5    Compressed Raw L60  CEV # R L60 

6    Compressed Default  CEV # 

7    Compressed B Command CEV # B 

8    ASCII EVE B Command  EVE # B 
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Following is what the Command field for an SEL-421 Relay used to be stored in the configuration: 

 

0~OTTER~TAIL~0~0~C~IP=196.72.197.177:4097 

 

The C in the 6th position indicates to use the Compressed Raw event command. The new command now 

looks like the below: 

 

 0~OTTER~TAIL~0~0~4~IP=196.72.197.177:4097 

 

The 4 replaced the C and indicates to use the 5th field in the drop down list. The index into the drop 

down list starts with 0 so the 4 is equal to the 5th field.  

 

Backward compatibility is also preserved. When the MID window is opened it will check if the Event File 

Type field stored in the Command field is a letter and convert it to its new number.  

 

The new SEL Event File Type.ini allows for adding up to a maximum of 50 commands. When the file is 

read all lines that start with a ; is ignored.  The ; allows for adding comments to the file. The format of 

the file is the title That will be placed in the drop down list box then the command separated by a 

comma. Add a # in the outgoing command field where the event number goes. When the command is 

sent to the relay the system will search for the # in the outgoing command string and replace it with the 

proper event number.  

 

It is recommended to compose the list of commands before configuring the devices, so the order is 

preserved. If new commands are needed, add them to the end of the file.  If new commands are added 

in the middle or beginning of the file then existing configurations will not have the proper commands. 

 

SEL Event File Type.IN File Contents 

;The list of all the SEL event commands that will be available under the Event File Type drop down list. 

;in the Device Configuration Dialog. There are two fields below separated by a comma.  

;The first field is the name that will appear in the File Type drop down list box. 

;The second field is the command sent to the relay. Put a # where the event number appears in the  

;command. 

;A maximum of 50 commands are supported. 

Default,EVE # 

Short,EVE # 

Long,EVE # L 

Raw (Unfiltered),EVE # R 

Compressed Raw,CEV # R 

Compressed Raw L60,CEV # R L60 

Compressed Default,CEV # 

Compressed B Command,CEV # B 
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ASCII EVE B Command,EVE # B 

12. Data Plotting – Digital Channel Titles: 

 

Updated December 17th, 2020 

 

Increased the Digital Channel title characters from 80 to 90. 

13. Data Plotting – Auto Process Templates: 

 

Updated December 17th, 2020 

 

Added 2 new fields in Display dialog under the Data Plotting tab. These 2 new fields are called PDF 

Width and PDF Height. When running Wavewin as a service the monitor coordinates for the PDF are not 

exact. These fields allow for changing the width and height to fit the PDF report properly. 

14. Device Manager – SEL/FTP Events: 

 

Updated December 17th, 2020 

 

Added the ability to connect to a SEL Relay using the TCPIP connection to check if there are new files for 

download. If there are new files then the FTP connection is used to download the new files. This was 

required because the level 2 password is used to logon to the FTP server and that causes alarms sent to 

SCADA. This will eliminate a majority of the alarms by only logging on to FTP server if there are new 

events to download. 

15. File Manager – Automatically Rename Files: 

 

Updated September 17th, 2020 

 

Added a new feature to Automatically rename waveform/load files to the IEEE ComNames format. This 

new feature monitors a folder for waveform/load files with user defined extensions. When a file is 

detected in the source path or in its included folders it will first move the original file to the Archive path 

then read the file’s configuration information and rename the file to the destination path. To activate 

this feature select the Auto Rename Files option under the Options menu/tab. A dialog will be displayed. 

Enter the Source Path, click the Include Sub Folders check box if needed. Enter the Destination and 

Archive Paths. Enter all file extensions (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to 

start when Wavewin runs click the Automatically Start Auto Rename Files at Run Time checkbox. The 

bottom section of the dialog gives a status update on the activity of the process. It displays the last scan 
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time, the original and Renamed filenames and when the next scan will start in minutes. To start the 

process click the Start Rename button. 

 

 
 

Figure-17: Automatically Rename Files Dialog 

16. File Manager/Process Templates – SER Reports: 

 

Updated August 29th, 2020 

 

Added a new feature to create SER files for each waveform file. This new feature monitors a folder for 

waveform files with user defined extensions. When a file is detected it will read the file and create a 

comma delimited SER file from the digital channel activity. The SER file will have the same name as the 

original waveform file. 
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Figure-18: Create SER File Dialog 

 

To activate this feature select the Create SER Files option under the Options menu/tab. A dialog will be 

displayed. Enter the Source Path, click the Include Sub Folders check box if needed, enter the file 

extensions (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to start when Wavewin runs 

click the Automatically Start Create SER File at Run Time checkbox. The bottom section of the dialog 

gives a status update on the activity of the process. It displays the last scan time; the original and SER 

filename being processed and when the next scan will start in minutes. To start the process click the 

Start Create button. 

 

To create an SER file with all the digital activity from all processed Waveform files click on the Create a 

Combined SER File check box. Select or enter the path of the Combined file and enter its filename. This 

allows for adding the SER information into a database from one single file. 

 



Softstuf Documentation 

20 

 

To create the SER files for each file being processed by the Auto Process Templates add a /SER to each 

line in the Format files being processed. 

17. Data Plotting – Auto Process Templates: 

 
Updated: June 15th, 2020 
 

Added a few new checks and features to the auto process template engine. 

1. When Comtrade files are automatically collected using the device manager the Comtrade .DAT 

file maybe collected first before the .CFG file is collected. If this happens then Wavewin will see 

the .DAT file as a Replay Plus file which causes an error in the system. To remedy this Wavewin 

will not process a Comtrade .DAT file until the .CFG file is collected.  

2. Again, when files are automatically collected using the device manager it may be possible that 

Wavewin will try to process the file before the full file is collected. To fix this, files are only 

processed if they have a save time greater than one minute from the current time. This was 

added to avoid conflict with reading files when they are being written to. 

3.  In previous versions Wavewin would process 256 files at a time. Before the process begins 

Wavewin would bin into memory all the information needed to process each file including 

renaming the file with a WWD added to the last field in the filename. Renaming the file with the 

WWD tag indicates the file has been processed. This was done to ensure the filename added to 

the DIG processed file’s information matched the filename on disk. This was causing a problem if 

Wavewin was shut down during a process session. All of the files that were not processed but 

were renamed never got reprocessed. To avoid this, renaming of the file occurs after the file is 

processed.  

4. Corrected a problem when opening waveform files from the processed DIG file. Since the 

filename is now marked as processed (adds a WWD in the last field in the filename) after the file 

is processed then it’s not writing the correct filename into the table at process time. To correct 

this when a double click occurs in the DIG file, the system checks if the file exists, if it does not 

exist it adds the WWD to the filename in the DIG file and tries to open that file. 

5. Added a new way to process files. In the past Wavewin would add a WWD to the last field in the 

filename to indicate a file has been processed. When using third party backup software to move 

files from one folder to another the third party’s software was constantly copying  back files that 

were previously processed.  It was doing this because it could not find the files since they were 

renamed by Wavewin. A second option was added to process files according to the file’s save 

date. In the System Settings dialog under the Data Plotting tab a new field was added to specify 

the process type, see Figure 1. If Rename with ,WWD is selected in the Process Type drop down 

field then the field to the right of the Process Type field changes to Batch Files. The batch Files 

drop down allows for selecting New Files (Files that do not have a WWD as the last field) or All 
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Files. If the By Save Date drop down option is selected then  the field to the right of the Process 

Type field changes to Start DT. The Start DT allows for setting what Date and Time to start at 

when processing the files. For example, to process just the last 30 days of files set the date and 

time to 30 days prior to the current date and time. 

6. Another field was added to give control over how many files get processed during a single 

session. The Process # field allows for selecting 1 to 256 files per session. 

7. Softstuf supplies a Fault Report template to process waveform files for fault information. In the 

Fault Report template there is a field for producing PDF files that gives a fault summary and a 

screen dump of the faulted area, refer to Appendix A. These PDF files were being produced for 

all fault files collected and processed. A large number of PDF files were being created that were 

not necessary. An option was added to select what files would produce a PDF. The new field is in 

the System Settings dialog under Data Plotting tab in the Process File section. The available 

options are All Files, No Files or Breaker Opt Files. In the fault report template there are 4 

columns used to monitor up to 4 breaker digital channels. If one of the 4 breakers operated then 

a PDF will be saved. 
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Figure-19: Auto Process Template Fields 
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18. Data Plotting – Digital Channel Groups: 

 
Updated: June 15th, 2020 
 

In the Save View dialog a new section was added to create digital channel groups. When a record is 

open, Wavewin will only display the digital channels that changed state. When creating digital groups all 

of the digital channels may have to be displayed prior to opening the Save View dialog. Before opening 

the Save View dialog select the All-Digital ribbon item in the Waveform tab. This will include all of the 

digital channels in the Save View dialog. 

 

The new Digital Groups section is disabled until the New Group button is clicked. To create a digital 

group use the Mouse to select the digital channels in the Digital Channel’s list box. Next, click on the 

New Group button. Once the New Group button is clicked the Digital Group section will be enabled and 

the Digital Group Name field will have the focus. Type in the name of the new group and hit enter or 

click the Save button. The table below the Digital Group Name field will be populated with the name of 

the digital groups in the first column and the number of channels in that group in the second column. 

 

 
 

Figure-20: Save View: Digital Groups 

 



Softstuf Documentation 

24 

 

 
 

Figure-21: Select View 

 

 
 

Figure-22: Digital Group Drop Down Menu 

 

In the Data Plotting window select the View that was saved with the Digital Groups. A new drop down 

button is added to the Data Plottting main toolbar. The new drop down lists all the Digital Groups in the 

View. To display a digital group select the group from the drop down menu. By default Wavewin only 

displays the triggered digital channels for each group. To view all the digital channels in the group click 

on the All Digital ribbon item in the Waveform tab. 

 

A View can also be selected from the Select View Dialog. Click on the Select View ribbon item under the 

Waveform tab. When the view is selected under the View Files section a new list is displayed next to the 

Digital Channel list box. It lists all the Digital Group Names and if the digital group is compatible with the 

displayed file. The group is compatible if it’s digital number and name in the group match the digital 

channels name and number in the file. 
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Figure-23: Select View Dialog 

19. Data Plotting – Auto Play Waveform: 

 

Updated: June 15th, 2020 
 

A feature to auto play the analog and digital channels has been added to Wavewin. In the ribbon system 

three new buttons were added to the data plotting’s main toolbar along with a new Replay section in 

the Ribbon under the data tab. In the menu system there are 3 new menu options under the data tab. 

The new options will auto play the displayed analog and digital channels. This new feature will move the 

channels to the left keeping the data cursor fixed at one cycle from the beginning of the display. In the 

Ribbon system the button to the left of the auto play button is used to slow the speed of the waveform 

movement and to the right is a button to increase the speed of the waveform. In the Menu System use 

the menu items increase/decrease to control the speed of the waveforms. 

 

All values in the tables are the values at the data bar.  
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The auto play Waveform does extensive drawing to the screen. To minimize flicker and slow drawing 

select a maximum of 7 channels and expand the time scale to see a smooth transition when the analog 

channels are played. The drawing is done in the background. This allows for marking, deleting, 

expanding, contrasting, scaling channels and more while the Waveform is being played.  

 

 
 

Figure-24: Auto Play Waveform 

 

    
 

Figure-25: Auto Play Waveform Menu Buttons 

20. Data Plotting – Digital Channels: 

 

Updated: June 15th, 2020 
 

Increased the number of digital channels from 2048 to 4096.  
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21. File Manager – Change Filename: 

 

Updated: June 15th, 2020 

 

A new feature was added that allows for changing the contents of a long filename. It can add or remove  

information from the marked files in the active folder or all the files in the active folder. The add feature 

adds the entered information as a new field to the right of the existing last field. This feature is helpful 

for adding the Company name to long filenames if it did not exist.   

 

It also allows for removing information from long filenames. This feature is helpful for processing 

waveform files that have already been processed by the Wavewin process temple feature. If the process 

template use the Rename with, WWD then to reprocess the files the ,WWD added to the end of each 

filename can easily be removed using the Remove check box.  

 

To add or remove information from long filename in a folder, first checked the desired checkbox, 

Remove or Add. Next enter the information to remove or add in the File String field. Next select what 

file to act on, Marked Files or All Files. If there are no marked files in the active folder then the Marked 

Files radio button is disabled. Click the OK button to activate.  

 

 
 

Figure-26: Change Filenames Dialog 
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22. File Manager – Rename Files to ComName Format: 

 

Updated: June 15th, 2020 

 

Removed a 14 character limitation for the station and device names in the ComName format when 

renaming files to the long format either directly from the File Manager or through the Auto Convert to 

Comtrade.   

23. File Manager – Auto Convert to Comtrade: 

 

Updated: June 15th, 2020 

 

When the auto convert to Comtrade copies waveform files to the destination path it was not copying 

the support files with the data file. This applied to Comtrade files, Emax files, Transcan file and 

Rochester files. It now copies all support files to the destination path. 

24. Device Manager – SEL Fault Report: 

 

Updated: March 20th, 2020 

 

Added an option to create an SEL Fault Report text file for each fault file retrieve from the SEL Relays. To 

activate this new feature open the Display Dialog under the Options menu/tab in the File Manager.  Click 

on the Device Manager tab. Click on the Create a Fault Report for each SEL Fault Retrieved check box. 

Next, select or enter the path where the fault report files will be saved. The contents of the report are 

listed below: 

 
 Date: 07/14/20 

      Time: 12:38:32.18 

   Station: BAIN SOUTH  

    Device: SOUTH STREET SET #2  

     Event: CG T 

  Location: +21.62 

   LineLen: 72.71 

   Targets: INST SOTF Level1 EN C G 
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Figure-27: SEL Fault Report Dialog 
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25. File Manager – Auto Convert to Comtrade: 

 

Updated: October 28th, 2019 
 

The Auto Convert to Comtrade feature converts all files with extensions matching the ones specified in 

the File Extensions field. 

 

The converted files are saved following the Comtrade Revision specified in the Properties Dialog under 

the Comtrade tab. All revisions of the Standard are supported including the latest single file format (CFF) 

which has helped solve many of the problems associated with managing very large volumes of Comtrade 

records. 

 
 

Figure-28: Auto Convert to Comtrade Dialog with New Advanced Setting Button 
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In addition, a new Advanced Settings feature allows for including subfolders and for automatically 

appending files from the same device which enables long term displays of both transient and periodic 

data. 

The new Advanced Settings feature also allows for automatically renaming the converted files to the 

standard IEEE Comname format. Setting details are provided in the following sub sections. 

 
 

Figure-29: Data Display Properties Dialog with CFF 2013 Revision Selected 
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Figure-30: New Advanced Setting Dialog 

 

Advance Settings: 

The Advanced Settings dialog has 3 sections, one for the Source path, one for the Destination Path 

and one for the Archive path. The Source path section allows for including Sub-folders when 

scanning for files to convert to Comtrade. The Destination and Archive sections allow for renaming 

to the Comname format. The Archive section also allows for appending all like files into one 

Comtrade file per year. If the append is checked then after each append the original archive files are 

deleted. 

Source Path:  

If Include Subfolders is selected, then the system reads all of the subfolders and their subfolders 

under the source path and puts them into a string list (the source path is included on top of the list). 

When scanning for new files, it starts at the first path in the list and then repeats for each 

subsequent path (multiple nests deep) (the number of nests is limited by the length of the path 

name, maximum allowable length is 128 characters). 

Destination Path:  

When a new file is found, it is first copied to the archive path and then it is converted to Comtrade 

and saved to the destination path. If the original file name is not based on a unique and readable 

naming scheme then the file name can be renamed to Comname in the destination path. 
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Archive Path:  

The file names in the archive path can also be renamed to Comname. If Rename is selected, then the 

renamed files can be automatically appended (1 file/device/year) by selecting the Append option. 

The appending process starts after the Conversion process is complete (for all of the paths in the 

list). This ensures that the conversion process is not delayed. The appending process scans the 

archive path and appends all of the files that have the same year, station, and device fields in the file 

name. 

The appended files are saved in the selected Comtrade version and are also named following the 

Comname format. After all of the files have been appended, the originating files are deleted from 

the archive path. 

26. Appending files from the File Manager and Data Display: 

 
Updated: October 28th, 2019 

 
The append engine is invoked from the file manager, from the data display, and now from the auto 
Convert to Comtrade feature. In support of the new features, the append engine was upgraded to allow 
for appending up to 400 files at a time (previous limit was 100). For periodic data, the 400 limit is just 
right because typically up to 366 files may be collected per year per device. For oscillography files, the 
400 limit provides large margins. Care must be taken when appending large numbers of files because of 
memory limitations. Typically each byte on disk corresponds to 10 bytes in memory. 
 
In addition, the file name in the data display window header was revised to show the number of 
appended files along with the name of the first appended file. For example, if 28 files were appended 
then the appended file name in the window header would look like: 
 
     28 Appended Files – The first file’s original name – Date and time – Values – (File type) 
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27. File Manager – Options Menu Item, Display Option, System Settings Dialog: 

 

 
 

Figure-31: System Settings Dialog with New Data Plotting Settings 
 
Updated: October 28th, 2019 

 

A number of new fields have been added to the System Settings dialog under the Data Plotting tab. The 

first feature is the ability to change the size of the font of the measurements shown in the data display. 

A drop down list is provided for selecting up to 16 font size (the default is 8). 

 

The second feature is a new, change detection algorithm to automatically measure duration and 

magnitude of evolving fault conditions within the same record (maximum/minimum over/under voltage 

and current magnitude and duration are calculated). The ability to set triggers for seeding the algorithm 

is provided under the Duration Calculation section. When a file is open a true RMS value is calculated at 

each sample using a running, recursive RMS calculation. After the first full cycle is processed, the 

algorithm kicks in and compares the calculated RMS values to the specified trigger values. 
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28. Data Plotting – New Semi F47-0706 Voltage Sag Chart: 

 

 
 

Figure-32: SEMI F47 0706 Voltage Sag Chart 

 
Updated: October 28th, 2019 

 

The SEMI F47-0706 Voltage Sag display shows the sag immunity chart. The chart depicts the required 

voltage sag ride-through capability curve. The unaffected region is the green area, and the miss 

operation region is the red area. 

 

 To view the chart, first mark the voltage channels then click on the SEMI F47 option from the Channels 

menu. 

 

To the right of the chart is the sag percentage which is calculated for each voltage channel using the 

following equation: (Nominal RMS *100) / (Lowest Sag RMS). Each displayed percentage is followed by 

the channel number and the duration in milliseconds. 

 

The trigger value for the duration calculation is set in the System Settings dialog (refer to Figure-4). The 

default setting is 15% of nominal. 
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29. Data Plotting - 3-D Plots: 

 

Updated: October 28th, 2019 

 

The Plot 3-D feature plots a maximum of 3 channels. To plot in 3-D, first mark the channels then click on 

the Draw 3-D icon under the Channels menu.  

 

 
 

Figure-33: Plot 3-D Window 

 

To the right of each channel is the channel number, the channel title, the instantaneous maximum and 

minimum values of the entire channel and the duration of the fault in cycles and milliseconds. 

 

The trigger values for the duration calculation are set in the System Settings dialog. The default setting is 

15% of nominal for the voltage channels, and times 5 of nominal per unit for the current channels. 

30. Data Plotting – Rose Charts: 

 

Updated: October 28th, 2019 

 

The Rose charts feature plots the waveform signal using the circular charts. To plot a rose chart, first 

mark the channels to plot then hit enter to isolate the channels. Next, click on the C button above the 

phasor diagram. The rose charts displays a small circle the same color as the signal color if the value is a 

negative value. To return to the phasor display click on the P button above the rose chart.  
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Figure-34: Rose Charts 

31. Data Plotting – Power Calculator: 

 

Updated: October 28th, 2019 

 

The Power Calculator measures the harmonics for a voltage and current channel. To open the power 

calculator first mark a voltage and current channel in the data plotting window. Next select the Power 

Calculator menu option under the Data tab in the menu system. In the ribbon system select the Power 

Calculator under the Data tab. A table is displayed listing the Voltage harmonics, Current harmonics, the 

angle difference between the current and voltage, the calculated MWatts and MVars. The MWatts and 

MVars calculations are below: 

MWatts = (V*I) * Cos(ØV– ØI) 

MVars = (V*I) * Sin(ØV– ØI) 
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Figure-35: Power Calculator 

32. Data Plotting – RMS Calibrated Channels: 

 

Updated: October 28th, 2019 

 

In RMS Calibrated Files added an option in the analog table popup menu to remove the root 2 multiplier 

from all of the marked analog channels. In the Channel display window added a * in front of each analog 

channel’s number to show the channel is multiplied by root 2. 
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Figure-36: Remove Root 2 Multiplier 

 

In RMS Calibrated files a new menu option was added to the analog table popup menu to Remove Root 

2 Multiplier from the marked analog channels. 
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Figure-37: Mark Channel’s when root 2 Multiplier applied 

 

In the Channel Window a star is placed in front of the analog channel number if has a root 2 multiplier 

applied. 

33. Data Plotting – Search Digital Channels: 

 

Updated: October 28th, 2019 

 

Modified the search digital channels option to mark and move the digital channels found to the top of 

the digital channels list. 
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Figure-38: Mark and Move Search Digital Channels 

34. Data Plotting – Save View Path: 

 

Updated: October 28th, 2019 

 

Defaulted the save view path to be the path where the file is located. In the past versions it would be 

the last path a view was saved in. 

35. Device Manager – Device Idle Report (Last Waveform Extracted): 

 

Updated: October 28th, 2019 

 

Added a new report in the Device Manager that displays a table listing the number of days idle since a 

waveform was extracted. The table columns are, Device #, Group #, Days Idle, Last Date, Station, Title 

and Driver Name. 
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Figure-39: Device Manager – Days Idle Report 
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Appendix A - Fault Report 
 

> Fault Report: 

 

              Station: South Arkey 

           Fault Time: 03/08/2017  03:57:42.006317 

            Equipment: Feeder 1202 

    Breakers Operated: Breaker 2 Closed  

           Fault Type: A, N 

 Fault Duration(Cycs): 3.893 

      Fault Mag(Amps): 14851.230 

       Voltage Dip(%): NA 

            V2(Volts): 18883.702 

             I2(Amps): 5226.823 

            VA(Volts): 26949.568 @0.000° 

            VB(Volts): 76249.703 @-106.062° 

            VC(Volts): 84881.925 @133.488° 

             IA(Amps): 14851.230 @-55.586° 

             IB(Amps): 1374.458 @99.968° 

             IC(Amps): 375.488 @41.528° 

             IN(Amps): 13622.515 @-51.698° 

 

 

> Event Report: 

 

     Start Time     Duration(ms)   Description 

     03:57:42.009   NA             Breaker 2 Closed  

     03:57:41.972   99             R3-Any Trip  

     03:57:41.971   66             Diff Trip A  

     03:57:41.996   29             Zone 1 A Trip  

     03:57:41.996   29             Zone 1 N Trip  

     03:57:41.984   70             Diff InterTrip  

     03:57:41.993   767            86-1 Operated  

 

 

> Location Report: 

 

          Line Length: 11.12 Miles 

             Z1(Ohms): 2.600 @75.499° 

             Z0(Ohms): 10.001 @52.500° 

            SE Radial: 3.851 Miles 

         SE Reactance: 4.022 Miles 

          DE Sequence: NA 
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